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By Richard Kennon, Editor,
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Drtrdguy(at)volcano.net

First, we must understand that photograph (image) size in the camera and in
the computer is measured in pixels. These are the basic dots of color that
make the picture. Do not pay any attention to anything that says “inches” or
“pixels per inch.” These terms are meaningless when we are considering a
picture either in the camera or in the computer. They may come into play
later if we want to print the photo on paper. But, that is another subject for
another time. For now, we think only of pixels. Most cameras record too
many pixels to e-mail. For instance a 6 megapixel camera will make a picture
about 3000 pixels wide by 2000 pixels tall and the file size may be several
megabytes. Our screens are usually only about 1000 pixels wide (some are
larger and some smaller). So, if we e-mail the native picture, it will be wider
than the screen for the recipient and the file will be so large, it may take
“forever” to download to the recipient’s computer. It is possible the service
provider will not even accept it.
There are two things we must do to make a photo e-mailable. The first is to
resize or resample the picture. We want to change the picture width from
3000 pixels to 800 pixels, for instance. This process is called resizing or resampling. We have to pick the best 800 pixels out of the 3000 to represent
our photo. Well, no, that is not exactly correct but it simplifies things to think
of it that way. We don’t have to worry about it because a lot of very smart pro(Continued on page 2)
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grammers have developed ways (algorithms) to help us. Just remember, you want to resize or resample to
get the photo down to a size convenient for e-mailing. I usually use 800 pixels or 900 pixels width for pictures I attach to e-mails.
The second thing to do to make a photo e-mailable is to save it in JPEG format (.jpg). That is a format
that reduces file size a lot and picture quality a little so the picture can be downloaded more quickly and
still be nice to look at. Some software programs give you choices of compression amount with numbers
ranging from 1 to 10. One will result in a very
small file but the picture quality will not be good at
all. A 10 will give the very best quality but with a
very large file size. A reasonable compromise is
to use 5 or 6. I usually use 6.
How do you do this? First, I will describe how to
do it with a free Microsoft program. Then I will try
to look at some other programs.
Microsoft Power Toys for XP has a Resize Pictures toy that is slick and easy but feedback says
it only works on XP. It can be downloaded at
http://www.microsoft.com/windowsxp/downloads/
powertoys/xppowertoys.mspx. Right click on an
image name or thumbnail in Explorer or My Computer and choose Resize Pictures. You are limited to four specific sizes but they are good
choices. They don’t tell us what compression they
are using but the results look OK. Unless you tell them under Advanced to replace the image in the file, it
will make a copy. That’s good. They will add the word, “Large”, “Medium” or “Small” to the end of the name
you have chosen.
If you are happy with this solution, then read no further. But, if you want to use a picture editing program,
maybe this will help.
In Photoshop Elements 5, click on Image>Resize>Image Size and this window will pop up. Note that
there is some garbage at the bottom about “inches” but we will ignore that. First we will click the Resample
Image box. That puts the Pixel Dimensions in play and that is what we want. I selected the Width box and
changed the width to 800 pixels. Since the Constrain Proportions box is selected, that is all I have to do.
Note, down at the bottom, that we have
several choices of sampling algorithms.
This is frosting on the cake. I read somewhere that I should use Bicubic
Sharper when downsizing so that is
what I do. Most programs don’t give us
all these choices. Then we should click
on File>Save As and give the photo a
new name. I often just use the same
name and add “_800px” so the next time
I will know it is ready to e-mail. Here we
can choose the JPEG format and the
compression amount. Photoshop Elements 6 is out now and sells for about
$100. If you are able to spend that much
(Continued on page 3)

PAGE 3

MOTHERBOARD

VOLUM E 26, I S S UE 8

(Continued from page 2)

and want one of the best editing programs, I highly recommend it.
Let’s look at Picasa2. It is a free program from Google and looks really good but I do not have much experience with it. By all means, try it first because the price is right! When it comes to e-mailing photographs, it is a little more automated but not any easier to use than Elements. First, click on
Tools>Options>E-Mail. Then select the width you want in pixels. There are six choices. Then click on Apply and OK.
The next step is to click on File>E-Mail
and you will get three choices of how you
want to e-mail your photos. Fortunately, I
use Outlook Express so my choice is
listed.
When I clicked on Outlook Express, an email page popped up with the photo attached. At this point we can write something else on the e-mail and send it. I recommend this so the recipient will know it
is really from you and not something sent
out by a virus. When I receive e-mails that
only say “Attached”, I Delete them without
looking at the attachment. This saved me
one time when I received a virus from my
sister-in-law that she did not know she sent. She spent weeks and dollars getting her computer back up.
Oh, I digress. If you want to send more than one picture (and, who doesn’t?), you must select the picture
and click on the Hold button near the bottom of the screen. Do this for each photo you want to send and
they will all be attached to the e-mail. The program automatically chooses JPEG format and a compression
ratio but does not tell you. That is OK as the pictures I tried looked good. Picasa2 has considerable capability for editing photos in many respects. Try it!
There are many other editing programs that I haven’t mentioned and have no experience with. In all cases
you want to change the picture’s size in pixels by resizing or resampling. Pay no attention to anything that
says “inches” as that will have no meaning for this process. Sometime later we will talk about printing pictures and then we will use inches.
This article has been provided to APCUG by the author solely for publication by APCUG member groups.
All other uses require the permission of the author (see e-mail address above).

For Anybody Who Has Thought About
Trying Linux
By Drew Kwashnak, Linux SIG Leader,
Danbury Area Computer Society, CT
www.dacs.org
dacseditor(at)dacs.org

a free download and is freely distributable. It is even available
already installed on Dell computers. The most common method
is downloading the ISO image from Ubuntu's website
(http://www.ubuntu. com) and burning it onto a CD.

From the site, you can download the Desktop version or Server
for 32-bit and 64-bit systems. There is even an option to
download what is called an alternative version which is just the
installer and does not include the LiveCD portion, which also
includes an installer. If you are like me, until a couple months
ago, and living on dial-up or you do not have a CD burner
For anybody who has thought about trying Linux, it has be- handy or just don't want to put in that much effort then you can
come easier than ever before with Ubuntu 8.04 LTS Hardy order a free CD through the corporate sponsor of Ubuntu, Ca(Continued on page 4)
Heron. As with most Linux distributions, Ubuntu is available as
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nonical, ShipIt department.
I have been very pleased with the speed with which their CDs
arrive. Alternatively, the website contains links to vendors
where you can buy the CDs from under $5 to more, and they
can handle large orders as well.
Once you have your CD in your hot little hands, trying Ubuntu
is as simple as placing it in your CD-ROM tray and rebooting
your system. If system will boot from the CD and after a short
moment you’ll be greeted with the Ubuntu welcome screen.
If you want to “try before you buy,” then you can choose the
default “Try Ubuntu without any changes to your computer”
and your hard drive will not be touched during your session
unless you choose to. You don’t even need a hard drive to select this option; you just will not be able to install it from the
session.
If you are more certain or just daring then you can go straight
into the installer and in about 60 minutes (45 minutes if you
know what Different Strokes For Anybody Who Has Thought
About Trying Linux by Drew Kwashnak you are doing) you’re
booting to your new Ubuntu installation.
Ubuntu will scan your hardware and load the modules and
drivers necessary for your system. If you have hardware that
has proprietary drivers available, Linux cannot include them in
the CD for legal reasons. Ubuntu works around this by providing a Restricted Drivers tool that lists all such hardware found
on your system and provides the ability to download and install the necessary drivers in a click or two, legally.
Now that you have Ubuntu up and running on your system,
what can you do? Plenty! Ubuntu brings you a full featured
operating system complete with:
Firefox 3.05 beta web browser;
OpenOffice.org 2.4 full featured office suite compatible with
pre-Office 2007 Word, Excel, PowerPoint and some Access
files;
Evolution personal information manager for email and calendar goodness, a Microsoft Outlook user can feel comfortable
with. There is even plug-ins to allow Evolution to access existing Microsoft Exchange servers;
Pidgin multi-protocol instant messenger including Yahoo,
MSN, AIM, Jabber, IRC and more;
Gimp (GNU Image Manipulation Program), a powerful
Photoshop-like image editing program that includes filters,
layers and a host of goodies;
F-Spot image manager for categorizing and minor editing of
all of your pictures as well as easily importing pictures from
your digital camera;
And much, MUCH more…
If Ubuntu doesn’t come with a particular application, thousands of free applications are available from the Ubuntu online
repository which are easily installed and updated from
the Synaptic package manager.
When you decide to install Ubuntu onto your hard drive or
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virtual machine you only need to click the “Install” icon on the
desktop to start the process. After seven or so easy questions
the installer will copy the files over to the hard disk. Depending on your system’s speed this could take about 60 minutes,
more or less. It will even detect if you have Windows installed
and offer to transfer over your files and compatible settings
from your Windows accounts!
Of course, if the limitations of the LiveCD, such as settings are
not saved from session to session, and you are hesitant to partition and install the full operating system on your hard drive
Ubuntu offers yet another alternative called Wubi. Wubi is,
from the Ubuntu website: “Wubi is an officially supported
Ubuntu installer for Windows users that can bring you to the
Linux world with a single click. Wubi allows you to install and
uninstall Ubuntu as any other Windows application, in a simple and safe way.
Are you curious about Linux and Ubuntu? Trying them out has
never been easier!” Wubi can be downloaded as an .exe file
directly. With Linux the installation is not the end, only the
beginning! Whether you try the LiveCD, Wubi or a full installation you will find a wealth of quality applications, refreshing
freedom and a community unlike any other! If you have problems, questions or want to find out more then you need look no
further than the third Wednesday of every month for the
DACS Linux SIG at 7:30 p.m. in the DACS Re source Center!
Drew Kwashnak: Has been losing more nights of sleep with Linux
since 2002 and just can't keep from downloading and trying the latest
versions! When not working with Linux he works with ASP.NET and
Microsoft SQL Server for a small financial company. He is also the
DACS Linux SIG leader and a father of 3.

Links:
Ubuntu: http://www.ubuntu.com
Get Ubuntu: http://www.ubuntu.com/getubuntu
ShipIt: https://shipit.ubuntu.com/
This article has been provided to APCUG by the author solely for
publication by APCUG member groups. All other uses require the
permission of the author (see e-mail address above).

Viewing the Bigger Picture
By Bonnie L. Snyder,
P*PCompAS, Colorado Springs, CO
http://ppcompas.apcug.org/
Bonniels21(at)gmail.com
At the risk of being the bearer of bad news, I have
to say that none of us is getting any younger. User
groups tend to be populated more by senior citizens
than by any other age group. As we age, we find
the need for more and more assistive aids, including those that will help us to use our computers
more comfortably and efficiently.
Many of us will find, as time goes on, that our vision
is not what it used to be. We may find that our eyes
(Continued on page 5)
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fatigue as we read information on the computer
monitor, and we may find that some of the smaller
fonts and graphics on the screen require us to
squint and lean forward into the display.
In this article, I will discuss two screen enlargement
programs that might help us minimize our visual
difficulties as we use our computers.
The first program I want to talk about is called
Magic Lens Max. I downloaded an older version of
the program from Giveawayoftheday.com and was
very impressed with what it could do. I e-mailed the
program’s author and told him what a terrific program it was and I have demonstrated it to various
groups who provide services to the blind and visually impaired. Additionally, the cost of the program
is only $39.95. I went ahead and purchased a copy
of the most recent edition and was even more
pleased with what the author had added since my
downloaded version.
Magic Lens Max provides a variety of ways to magnify the computer screen, from resizable moveable
lenses, which magnify directly over where your
mouse or cursor is working, to a full screen magnification option, which slows down the screen refresh
very minimally. You have some color contrast options to choose from with this program as well as an
invert colors option for light text on dark background. The magnification levels can be selected
from 50% (which is non-magnification) up to pretty
much infinity. Anything above 350% starts to blur a
bit, although there are options to sharpen. Below is
the Magic Lens Max option screen: <insert
magic_lens_max>
The Magic Lens Max icon that resides in the system
tray can be single-clicked to turn on or turn off the
magnification.
This is an excellent program that is both useful and
affordable. If you are interested in testing it out, go
to www.visionsuit.com. You can download a 30-day
demo of the latest version. If you decide to purchase Magic Lens Max, once you have paid the
$39.95, you will be sent a registration code that can
be entered into the demo, and it becomes fully functional.
The second program I evaluated for screen magnification allows for an additional option: speech along
with the magnification. This program is called
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iZoom, and can be obtained from http://
www.issist.com/. I really like the customizing options available in iZoom. These can be accessed
from the initial menu when iZoom comes on, or
once the menu is closed, you can reopen it quickly
by clicking the mouse on the iZoom icon in the system tray. Here are the option screens: <insert
izoom1 and izoom2>
iZoom allows for default or customizable hot keys,
several sizes and colors of mouse pointers, color
combinations supplied with the program, as well as
custom color modes, several sizes and shapes of
“locators” that help the user find the location of the
mouse pointer, and a choice of several lens
shapes, as well as full-screen magnification. iZoom
magnifies from 1X to 32X.
The negatives I have found in iZoom are as follows:
First, when using the lens mode, you have to place
the lens first over what you want to interact with,
and then move the mouse pointer within that lens.
Second, from about the 3X magnification up, the
display becomes more and more pixilated which
can be a problem for some vision conditions, such
as astigmatism, among others. Third, there is only
one voice offered with the speech option and it is
not a particularly pleasant one.
As you would expect, with additional options comes
an additional cost. Again, you can download a 30day demo of iZoom from the Website, and if you
wish to purchase the program, the price is $199.00.
However, keep in mind that the two major commercial screen magnification programs, MAGic from
Freedom Scientific and ZoomText Plus from AI
Squared, both weigh in at from $300.00 to $550.00,
depending on how many options you wish to have.
So, if you feel the need to view the bigger picture,
give the demos of the above programs a try, and
see if they will be of use to you.
This article has been provided to APCUG by the author solely for
publication by APCUG member groups. All other uses require the
permission of the author (see e-mail address above).

Email Etiquette
By John Roy, President,
The PC Users Group of Connecticut
www.tpcug-ct.org/
johnroy1(at)comcast.net

Do you really know how to forward an e-mail? It is
estimated that over fifty percent of email users do
not know how to do it properly. Do you wonder why
(Continued on page 6)
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you get viruses or junk mail? Email messages get
forwarded countless times without concern for the
security of the previous sender’s addresses.
Every time you forward an e-mail there is information left over from the people who got the message
before you, namely their e-mail addresses and
names. As the messages get forwarded along the
list of addresses builds and builds creating a huge
resource for spammers. All it takes is for someone
to get a virus and the infected computer can send
that virus to every e-mail address that has come
across that computer. Even if the address collection
doesn’t result in a virus it surely will be harvested by
spammers or someone looking to make a couple of
cents for a listing of good email addresses. How do
you stop or at least minimize the propagation of
email addresses? There are several easy steps that
we should all practice.
(1) Before you send out a forwarded e-mail, DELETE all of the other addresses that appear in the
body of the message (at the top). That's right, DELETE them. Highlight them and delete them, backspace them, cut them, whatever it is you know how
to do. It only takes a second You MUST click the
'Forward' button first and then you will have full editing capabilities against the body and headers of the
message. If you don't click on 'Forward' first, you
won't be able to edit the message at all.
(2) Whenever you send an e-mail to more than one
person, do NOT use the To: or Cc: fields for adding
e-mail addresses. Always use the BCC: (blind carbon copy) field for listing the e-mail addresses. This
is the way the people you send to will only see their
own e-mail address. If you don't see your BCC: option click on where it says To: and your address list
will appear. Highlight the address and choose BCC:
and that's it, it's that easy. When you send to BCC:
your message will automatically say 'Undisclosed
Recipients' in the 'TO:' field of the people who receive it.
(3) Remove any ‘FW:' in the subject line. You can
re-name the subject if you wish or even fix spelling.
(4) ALWAYS hit your Forward button from the actual e-mail you are reading. Ever get those e-mails
that you have to open 10 pages to read the one
page with the information on it? By forwarding from
the actual page you wish someone to view, you
stop them from having to open many e-mails just to
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see what you sent.
(5) Have you ever gotten an email that is a petition?
It states a position and asks you to add your name
and address and to forward it to 10 or 15 people or
your entire address book. The email can be forwarded on and on and can collect thousands of
names and email addresses. A FACT: The completed petition is actually worth a couple of bucks to
a professional spammer because of the wealth of
valid names and email addresses contained
therein. If you want to support the petition, send it
as your own personal letter to the intended recipient. Your position may carry more weight as a personal letter than a laundry list of names and email
address on a petition. (Actually, if you think about it,
who's supposed to send the petition in to whatever
cause it supports? And don't believe the ones that
say that the email is being traced, it just isn’t so!)
(6) One of the main ones I hate is the ones that say
that something like, 'Send this email to 10 people
and you'll see something great run across your
screen.' Or, sometimes they'll just tease you by saying something really cute will happen IT AIN'T
GONNA HAPPEN!!!!! (Trust me; I'm still seeing
some of the same ones that I waited on 10 years
ago!) I don't let the bad luck ones scare me either,
they get trashed. (Could that be why I haven't won
the lottery?)
(7) Before you forward an Amber Alert, or a Virus
Alert, or some of the other ones floating around
nowadays, check them out before you forward
them. Most of them are junk mail that's been circling the net for Years! Just about everything you
receive in an email that is in question can be
checked out at Snopes. Just go to http://
www.snopes.com/. It’s really easy to find out if it's
real or not. If it's not, please don't pass it on.
So please, in the future, let's stop or at least minimize the junk mail and the viruses by taking the
steps outlined above.
This article has been provided to APCUG by the author solely for
publication by APCUG member groups. All other uses require the
permission of the author (see e-mail address above).
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CLUB SUPPORTERS
THE SECRET GUIDE
TO COMPUTERS
The Secret Guide is available at every New
Orleans Personal Computer Club General
Meeting. The latest printing is available for
only $15.00. Or contact Ray Paternostro either
at: secretary@nopc.org or (504) 737-9099.

vehicle race.
The three owners of the Gray Insurance Co. have alIn spite of Hurricane Katrina, being a newcomer, and
ways focused on developing new technology and new business
opportunities such as surety and bonding, oil and gas explora- competing with experts such as MIT, Carnegie Mellon, Stanford, General Motors, Raytheon, Boeing, Ford, Honeywell,
tion, real estate transfers, and real estate management.
General Dynamics, and Google, Team Gray was one of only
An article in Popular Science Magazine about four teams to finish the historic race.
DARPA’s quest to satisfy a Congressional Mandate to make
Team Gray then qualified for the 2007 Urban Chalone-third of the military’s vehicle fleet autonomous
lenge,
which
was an autonomous vehicle race in an urban envi(unmanned) within ten years spurred the Gray Insurance Comronment,
where
vehicles had to deal with complex traffic scepany to field a team in the November 2005 Grand Challenge,
narios,
parking,
and
other challenges found in city driving.
where 195 teams competed to win the 132 mile autonomous
(Continued from page 1)
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The New Orleans Personal Computer Club (NOPCC) is a private non-profit organization chartered under the State of Louisiana. Its purpose is to provide an open forum for discussion
and education of the membership in the use and application of PCs, peripheral equipment and software. The opinions expressed in this newsletter are those of the author (s) and do not
necessarily reflect those of the NOPCC , its members or its officers. The club does not verify for accuracy the articles in this newsletter and leaves verification of accuracy to its readers.
Articles in this newsletter may be duplicated as long as credit is given to the author (s) and the NOPCC. Annual Dues Schedule: Regular Member, $40/yr.; Family Membership, $60/yr.;
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